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Manuscript preparation guidelines
for authors of physica status solidi
– Word document
This manual is part of the template package for authors
preparing their work for submission to pss in MS-Word
format. It provides general information on manuscript
properties in the pss journal family and a brief introduction to the technical usage of the package’s template file.
There is a section on style and layout conventions, and
the manual itself is formatted according to the pss layout
as an example.
For information on the journal scope, the editorial policy
regarding scientific content and peer review, and the
submission and production process please visit the pss
journal homepage at www.pss-journals.com.

1 General
1.1 Journal series and templates physica status solidi has four sister series, all of which are dedicated
to documenting the progress in solid state physics research,
but differ with regard to their special scope and journal
production process (see Table 1). pss (a), (b), (c) and
(RRL) use the same template for all article types. The pss
templates come in a Microsoft® Word Office (this) and a
LaTeX version (different download). A Word document is
the preferred file-format for submission.
Original Papers in pss (a) and (b) have no length limit.
pss (RRL) Rapid Research Letter articles are restricted

Selected covers of pss (a), (b), and (c) as an example for
the optional abstract figure (with or without caption). If
there is no figure here, the abstract text should be divided
into both columns.

to a length of 3000 words and 4 display items (tables or
figures, not page-filling). In the manuscript template this
should typically not exceed four journal pages. Invited Review@RRL contributions can have a length between 6 and
15 pages. Table 1 shows an overview of the article types.
For manuscripts submitted to pss (RRL), (a) and (b) we
strongly recommend using the template to gain an accurate length estimate and control over the design, but accepted articles need no perfect layout since they undergo
full typesetting with author proof corrections during production. Articles for pss (c) must use the template.

Table 1 Overview of the pss journal series with regard to template use, journal production and submission policy.
Journals

Article formats

Submission

Length restriction

Production

Template use

pss (a)
– applications and materials science

Original Paper

none, typically 8 pages

typesetting,
author proof
corrections

strongly
recommended

Feature Article

regular unsolicited
submission
invited

pss (b)
– basic solid state physics

Review Article

invited

10 pages minimum

Past & Present

invited

Expert Opinion

invited

pss (c)
– current topics in solid
state physics

Contributed Article

special publication
projects, conferences

varies for specific projects

publicationready

mandatory

pss (RRL)
– Rapid Research Letters

Rapid Research Letter

regular unsolicited
submission

typesetting,
author proof
corrections

strongly
recommended

Review@RRL

invited

3000 words, 4 display
items (figures or tables,
not page-filling)
6 to 15 pages, up to 50
references

Invited Article

10 to 15 pages
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1.2 pss (c) special information Length limits of
Contributed or Invited Articles in pss (c) may vary for different conferences or special projects. Articles designated
for pss (c) must be prepared publication-ready in a
template and according to the journal style, fully formatted and arranged fit for printing. There will be no author
proof corrections. Please do not modify any pre-settings in
the manuscript templates/style file such as font sizes, margins, and other formats, to avoid an incorrect layout of the
publication. Manuscripts with wrong template use may
have to be returned to the authors by the Guest Editors or
the pss Editorial Office.
1.3 Formal manuscript requirements Manuscripts must be written in correct English (British spelling
preferred, American also possible, please be consistent)
and submitted as one single MS Word- or pdf-file (including all text and figures etc.). Authors should structure their
work in sections with subheadings of their choice. The following components are essential:
– a title in lower case letters except for the first word and
proper nouns, and preferably a suggestion for a short title
in the header on the second page,
– the full list of authors (full names preferred, first name
initials also possible) with their affiliations (institution
from smallest to largest unit, postal address including
country),
– a footnote indicating the corresponding author including a valid e-mail address (telephone, fax, web-site optional; additional footnotes with other authors’ contacts possible),
– about four keyword suggestions (Articles are classified
with keywords to enhance discoverability. Keywords
should be comprehensive, reflect the essence and major
aspects of the work, and be as precise as possible. Avoid
expressions which are not generally known by the physics
community, especially abbreviations.),
– an abstract which concisely summarizes the reported
study and results (optional: eye-catching abstract figure
with or without brief caption in the right column; if there is
no abstract figure, the abstract text should be divided into
both columns),
– an introduction or motivation (please put your results
into their scientific context, outlining the progress achieved
in the present study in comparison to information already
available in the literature from the authors’ and other researchers work),
– a main part with sections devoted to the theoretical or
experimental methods, results and discussion,
– conclusions revisiting the main results and derived findings (keep in mind that the scope of the abstract is different
from that of the conclusions),
– optionally acknowledgements,
– bibliographic references (see Section 3 for details),
– dates of receipt, receipt of the revised version and acceptance will be added by the publisher, as will logos,
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Table 2 Fonts and font size conventions for pss manuscript components as defined in the template.
pss-styles

Font

Size

01_Title
02_Author
03_Address
04_Received_Date
05_PACS
06_Footnote
07_Email_Address
08_Abstract
09_Body_text
10_Free-standing_Heading
11_Inline_Heading
12_Equation
13_Figure_Caption
14_Table_Title
15_Table_Body
16_Table_Legend
17_Acknowledgements
18_ References

Arial/Helvetica
Arial/Helvetica
Times New Roman
Times New Roman
Times New Roman
Times New Roman
Arial/Helvetica
Times New Roman
Times New Roman
Arial/Helvetica bold
Arial/Helvetica bold
Times New Roman
Times New Roman
Times New Roman
Times New Roman
Times New Roman
Times New Roman
Times New Roman

18pt
10pt
9pt
9pt
9pt
9pt
8pt
9pt
10pt
10pt
10pt
10pt
9pt
9pt
9pt
8pt
9pt
9pt

copyright lines, page headers and the coloured abstract
background.
Supporting information like videos, animations or
other file formats to be hosted on Wiley Online Library
should be mentioned in the cover letter as well as clearly
referred to in the manuscript, and uploaded as supplementary files. For details and best practices for supporting information please refer to the Author Guidelines section on
the journal homepage.
2 How to use the Word document template
Open the template file pss_author_style_file.dotx and save
it as DOCX file your_manuscript_name.docx. Then replace the dummy-text in the template with your input.
Please do not change the pre-defined margins, font sizes,
and other dimensions.
2.1 Applying styles The template provides predefined pss styles for specific text components edited by
the authors of a manuscript (Table 2). Office 2003 lists
them in the drop-down menu with the default formats, Office 2007/10 users can find the pss styles by clicking the 
arrow in ‘Menu: Start > Styles’). There are two ways to apply
a style to an item in the manuscript:
1. Retain the style of the dummy-text when you replace
it with your input. If you draft in another file and copy
from there, click on the context-related ‘insert’-icon that appears after pasting. Here you can determine if styles should
be kept or adapted for the inserted text (Note that ‘insert text
only’ will lose any sub- and superscript formatting though.).
2. Mark the text after typing and click on a style.
Example: To insert and format the corresponding author
information, place the cursor at the end of the name, go to
‘Menu: Insert > Reference > Footnote’, activate ‘06_Footnote’,
type ‘Corresponding author: e-mail pss@wiley-vch.de’,
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Figure 1 The plot shows the number of articles N published in
pss versus time t. The colours refer to the four different journal
family members as indicated in the legend.

mark the e-mail address and select ‘07_Email_Address’ to get
‘Corresponding author: e-mail pss@wiley-vch.de’.
2.2 Inserting figures There are several possibilities
for adding graphics with captions to a Word-file (for format conventions and technical graphics requirements see
Section 3).
1. Plain: Position the cursor at the chosen site in the
body text. Then simply insert the graphics file (‘Menu: Insert
> Graphics > From File’) and edit its properties with respect to
scaling and positioning options. Add the caption directly
below the picture and then continue with the body text.
This method is simple, but carries a practical disadvantage:
Picture and caption will not float within the text as a unified element (cf. Fig. 1).
2. Table: Place the cursor at the intended position in
the body text, insert a table with two cells (‘Menu: Table >
Insert’, either 1 column and 2 rows or 2 columns and 1 row)
in ’simple’ auto-layout (no frame lines), and format the
width of the table. For positioning, first choose the table
layout property ‘floating with text’. Then set a vertical and
horizontal distance with respect to the page margins. Before inserting the figure into a cell, the line spacing of the
paragraphs within should be set to ‘regular’. Paste your figure into the upper or left cell (important: graphics layout
properties need to be ‘text in line’), and add a caption in the
other cell. This method has graphics and captions floating
in the text together, but may involve some complicated
menu-navigation.
3. Textbox: Place the cursor at the intended position,
open a text-field (‘Menu: Insert > Text-field’), and paste your
figure inside. Add a caption within the text-field below the
picture. Size and position of the floating element in the
body text is then a layout property of the text-field and can
be edited in the related context-specific menu. This method
usually works well for writing and editing, but may cause
conversion difficulties and errors during typesetting.
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3 Layout and style conventions The standard
fonts as defined in the template are listed in Table 2. Please
use Times New Roman, Times, Arial, Helvetica or Symbol ( fonts as much as possible, since other fonts
(e.g., Asian or Russian character fonts) may cause conversion problems.
The title is not capitalized, but in lower case letters except for the first word and proper nouns.
Section headings come as in-line running heads in
lower case letters except for proper nouns, certain abbreviations, physical quantities and the like. They should be
consecutively numbered by decimal numbers as 1, 1.1, 2
etc., followed by a space and the heading text. After a further space the body text starts on the same line. The freestanding heading-style (pss-style 10) is reserved for the
first of two consecutive headings.
The number format uses a decimal point (not a comma)
and scientific notation as in 2.1  10–4 , or alternatively
0.21 m (no engineering notation like 2.1E–4, also in figures).For symbols and units, avoid writing alpha, Ohm,
deg; use Greek and special characters instead: , , °. All
physical quantities and constants should be given in italic,
vectors in bold italic letters (both in the text and in equations). Please distinguish carefully between subscripts, superscripts, and special symbols. Units (e.g. V/cm, K, Pa
etc.) should be written in upright letters (not in italics) with
a short space to the number before. Please use SI units
throughout. Mathematical functions which are tabulated
(e.g. sin, cos, exp, e, etc.) should be given in upright letters
(not in italics).
Equations may be numbered sequentially. Except for
small in-line equations, they should appear on separate
lines, such as

G

N
ab 
b1bn1  c b2 a n .

i cos a n 1
n 1

(1)

In the text, equations may be referred to by writing
” in Eq. (1)”. At the beginning of a sentence, use the full
form “Equation (1) shows ”.
Figures and tables can be one (8.4 cm) or two columns
(17.2 cm) wide, have captions below, above, or to the side,
and are preferably placed at the top or bottom of a page.
They are referenced in the text as “Table/Fig. 1”, or “Table/Figure 1” at the beginning of a sentence. Please limit
the number of figures to maintain a reasonable relation to
the amount of text.
Figures must be carefully prepared ready for production. Lettering and symbols should be no less than 1.5 mm
high. Avoid small open symbols, small dots, small decimal
points, hairlines, close-dotted or short-dashed lines. Draw a
closed axes frame in diagrams with the axis titles (quantity
or symbol followed by the unit in brackets, like “Raman
shift (cm–1)”) parallel to the corresponding axis, outside the
frame.
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Captions start with the number of the figure, spell out
the plotted quantities by variable and full name, and end
with a full stop. Remember to label each plotted data trace.
Please use only standard fonts (Arial, Times New Roman,
Symbol) or include the fonts in the figure file. When composing a figure, avoid using separate drawing elements in
Word such as arrows, symbols or letters, since these are
sometimes lost if a figure must be extracted from the Word
file during typesetting. All elements of a figure should be
grouped together as one graphics object.
Halftone figures should have 300 dpi, line drawings
600 dpi minimum resolution in final size. Screen or Web
resolution is insufficient for publication.
Colour figures will generally remain in colour in the
internet PDF version at no cost. The print version of pss
(a/b/c) will be black/white unless colour figures are purchased by the authors using the colour print authorization
on the Reprint Order form when returning proof corrections.
References should be numbered by order of appearance in the text, denoted in square brackets inside the sentence, such as [1], [1, 2] or [1–3], and listed at the end of
the manuscript [1–10]. Please do not use the footnote/endnote function which is inherent to MS Word. Additional tools such as the (commercial) software EndNote®
(www.endnote.com) allow for convenient bibliography
management with respect to both correct numbering and
style.
Please adhere to the journal’s reference scheme, which
is: Author names, Journal title according to the INSPEC
List of Journals abbreviations (in January 2009 the abbreviation changed from “phys. stat. sol.” to “Phys. Status
Solidi”), followed by volume number in bold face, starting
page, and year of publication in brackets [1, 2]. Articles
may be cited by digital object identifier (DOI) if they have
not yet been assigned volume and page numbers [3]. In this
case the journal abbreviation and year is required to enable
correct citation counts in literature databases (i.e. citations
of the DOI can then be correctly mapped to the article with
its volume and page number reference). For references to
books see the examples [4–6]. When citing conference
proceedings, please add all available data such as title, date,
and place of the conference as well as publisher, place, and
year of publication or, alternatively, the corresponding
journal citation [10].
4 Manuscript submission Please finish your manuscript by checking that it contains all the essential information listed in Section 1.3 and meets the length restriction
if applicable. Then upload one single file of your manuscript (with all figures embedded) to (only) one manuscript
submission system at
pss (RRL)
www.editorialmanager.com/pssrrl-journal,
pss (a)
www.editorialmanager.com/pssa-journal,
pss (b)
www.editorialmanager.com/pssb-journal,
or

pss (c)

mc.manuscriptcentral.com/pssc .
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For publication in pss (c) production will be based directly
on your fully formatted, publication-ready file. No page
proofs will be sent. Organisation and handling of submissions to conferences and special issues may vary. Please
follow the specific information given by the event’s organisers. Do not send your manuscript to the Editorial Office
unless the organisers or Guest Editors have explicitly instructed contributors to do so. Further information is available at ‘www.pss-c.com > Author Guidelines’.
Manuscripts accepted for pss (a), pss (b), or pss (RRL)
will undergo typesetting with author proof corrections. For
information on the submission consideration process for
your article as well as on the Editorial Board please refer to
the journal homepages (www.pss-journals.com). If you
have any further questions or experience technical problems do not hesitate to contact us at pss@wiley-vch.de.
Thank you for taking the time to consider these instructions. We wish you success with the manuscript preparations and look forward to your submission to pss.
Acknowledgements We gratefully acknowledge the
Druckhaus Thomas Müntzer, Bad Langensalza, for providing the
MS Word template.
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